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This document describes the ins and outs of managing resources and creating office standards 
in various workplace situations. The intent is to help firms of various sizes use the Vectorworks® 
resources in an effective way, and this document will cover server setup recommendations, user 
folders, workgroup folders, etc.

A resource is defined as “a source of supply, support, or aid, especially one that can be readily 
drawn upon when needed.”

In Vectorworks, a resource is exactly that — resources are embedded in each Vectorworks file and 
can easily be reused in other files. When referring to libraries or resource libraries, this means a 
group of files containing several types of resources.

Whether you are working in a large or small office environment, resource libraries must be well 
organized and managed. This will increase your productivity by reducing the time each user spends 
finding the resources and by ensuring consistency and accuracy in your models, thus reducing 
errors in the documentation of your projects.

TYPES OF RESOURCES

Vectorworks files can contain hundreds of resources. The following is a list of the types of resources 
you can find in a file:

 ∙ Gradients

 ∙ Hatches

 ∙ Images

 ∙ Line Types

 ∙ Record Formats

 ∙ Renderworks® Backgrounds

 ∙ Renderworks Styles

 ∙ Renderworks Textures

 ∙ Roof Styles

 ∙ Scripts

 ∙ Sketch Styles

 ∙ Slab Styles

 ∙ Symbols/Plug-in Objects (2D, 3D, 2D&3D, PIO styles)

INTRODUCTION
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 ∙ Text Styles

 ∙ Tiles

 ∙ Wall Styles

 ∙ Worksheets

In addition to the resource libraries, it is important to prepare a custom template file, 
which could contain office-specific standards such as class and layer naming standards, 
sheet layers, and typical stories and story levels. Using a template will save you time, as 
it helps eliminate setting up each individual file at the beginning of every project.

OFFICE STANDARDS

Having a set of standards to produce models and drawings is important to increase 
productivity and help maintain consistency throughout all projects. The quality of 
a document’s graphics is often the first impression an architect presents to his/
her client and contractors, as this is your primary means of communication.

The quality and consistency of your project documentation directly depends on how your 
team works in the office. If we go back in time to when the drafting board was our primary 
tool, we followed the graphic standards book for our drafting conventions. Today, the 
technology available gives us a lot more possibilities and flexibility; therefore, the simple 
graphic standards are no longer sufficient. With the BIM process and advanced tools 
like Vectorworks, the creation of office standards allows a firm to consistently produce 
quality documentation and becomes part of the firm’s commitment to this reputation.

WHAT SHOULD BE PART OF YOUR OFFICE STANDARDS?

Office standards will vary widely from firm to firm depending on the size of each office. Here 
is a list of office standards that could directly affect the efficiency of your workflow:

1. Project setup standards:

a. Project and file naming standards

b. Project folder structure and naming standards

2. Standard templates (file setup standards)

a. Class naming and attributes standards

b. Design layer naming standards

TYPES OF RESOURCES (CONT’D)
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c. Stories and story levels

d. Sheet layer numbering and naming conventions

3. Graphic standards

a. Font type and size for dimensions, notes, drawing title, sheet title, project title, etc.

b. Title block graphics (title block border styles)

c. Line types, thickness, color, etc.

d. Hatches (wall/slab style components, fill attributes, material representation)

e. Other attributes resources like gradients, tiles, etc.

4. Libraries

a. Wall styles

b. Roof styles

c. Slab styles

d. Door styles

e. Window styles

f. Other object styles (from PIOs)

g. Symbol libraries: Symbol libraries can include hybrid 2D/3D symbols for building 
fixtures and furniture, such as plumbing and electrical fixtures, symbols specific to 
your project type, and typical 2D details to be used for construction documentation.

5. Worksheets: pre-set door/window/finish schedules, quantity 
takeoff templates, code analysis, and more

6. Renderworks resources: textures, styles, and backgrounds

While the office standards list is quite extensive, building office-wide resource libraries will not 
happen overnight. This is a process that will take time to create and build upon. So where should 
you start? This will depend on several factors: 

1. What is your primary workflow? 2D drafting only or a BIM workflow? 

2. What tools are you currently using?

3. What are your goals in using a digital model?

For firms that have used Vectorworks for a long time, it may be just as easy as organizing the 
existing resources within new Vectorworks files.

For firms that want to implement a BIM workflow, there are a few libraries that will need to be 
carefully prepared to make the smoothest transition possible. 

OFFICE STANDARDS (CONT’D)
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CREATE YOUR OWN TEMPLATE

A template file is the first and most important thing you need to have. Vectorworks has 
pre-set templates you can use. These templates are a good way to start, but they are not 
necessarily customized for your individual needs. At a minimum, your template should include 
most, if not all, classes, layers, stories, and story levels. Templates should accommodate 
the type of project and construction type you utilize the most. For example, if your firm 
specializes in multi-story commercial/institutional projects, your template might include 
three or more stories. In this case your template will be different than if you are primarily 
focusing on residential design with wood-frame construction and pitched roofs.

The construction type can also affect how you will approach the setup of your templates, such 
as wood framing bearing wall vs. steel or concrete construction, and renovation project vs. new 
construction,. Depending on factors such as these, your template file and wall, roof, slab, window, 
and door styles should be customized and made available to all users within your office. 

When creating a custom template, there are a few resources that should be included:

1. Standard classes (names and graphic attributes)

2. Standard design layers (names, elevations, and wall heights)

3. Story levels and stories (for BIM projects)

4. Sheet layers (with standard title blocks of different sizes)

When using a BIM workflow, it is important to understand the concept of stories and 
story levels in Vectorworks. Click here to download the “model setup tutorial” and learn 
more about how to correctly set up your template with stories and story levels.

Another document for creating a template for a renovation project is available here. This  
document explains how to use layers, classes, and object styles to represent demolition and 
construction plans.

To create a custom template, you can simply make all your custom template modifications in 
a standard Vectorworks file and save the .vwx file as a .sta (template) file; from the Menu bar, 
select File → Save As Template. To share a custom template, the file must be saved in a specific 
workgroup folder as described in the “Configuring Workgroup Folders” section of this document.

OFFICE STANDARDS (CONT’D)

http://download2cf.nemetschek.net/bim/introductiontoprojectsharing1490908350.pdf
http://download2CF.nemetschek.net/www_misc/bim/Model+Setup+for+Renovation+Projects.pdf


FIGURE 1 
Vectorworks resource libraries location
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WHAT TYPES OF LIBRARIES DO I NEED,  
AND WHERE SHOULD THEY BE LOCATED?

As described in Types of Resources section, there are various sources to pull resource libraries from.

VECTORWORKS LIBRARIES
Vectorworks libraries are located within the Vectorworks application folder, and you should not 
have to change or modify their locations. Vectorworks libraries include defaults libraries, object 
styles libraries, and other libraries for symbols, textures, and more. The defaults and object styles 
libraries are automatically installed and updated during the software installation process. The other 
content libraries can either be installed during the software installation or after. 

Note: If you choose not to install the Vectorworks libraries, these resources will 
be available on demand through the Resource Manager (this requires an internet 

connection), or they can be downloaded from the Help > Download Content.

SUBSCRIPTION LIBRARIES

OFFICE STANDARDS (CONT’D)
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Subscription libraries include additional, exclusive content files available with a Vectorworks Service 
Select membership. These on-demand libraries are available directly from the Resource Manager. 
You can also download these resource files through the Vectorworks Service Select internet portal; 
in this case, the downloaded files will need to be organized within the Vectorworks library folders.

USER LIBRARIES
User libraries are located in the User Data and Preferences folder. This folder is also created by 
default during the software installation process and is located on your local hard drive in a hidden 
folder. 

~Libraries > Application Support > Vectorworks > 2018. 

This folder should remain intact per the default installation, as it stores your local Vectorworks 
preferences and licensing information. It also contains a library folder similar to the Vectorworks 
defaults libraries. This location can be used to store personal libraries if you choose to.

WORKGROUP LIBRARIES
Custom resource libraries or workgroup libraries are the files you will need to manage when 
creating a set of office-wide standards. Workgroup libraries can be located either on your personal 
computer or on a shared server. In offices with more than one user, these libraries should reside 
on a server so everyone can access them in real time (a workgroup folder can also be shared using 
cloud storage).

Note: In larger offices, it may be desirable to restrict access to one (or a few) user(s) to 
maintain the integrity of your office libraries. Often, a system is in place defining who 
will have the “permission” to modify these libraries . When located on a server, you can 
control and limit who will be able to change/overwrite these files by assigning the proper 

permissions to various users. This will be assigned by the network administrator. 

To assign the location of your workgroup libraries, select Vectorworks Preferences, click the 
User Folder tab, and the Workgroup and Project Folders list shows the list of folders that contain 
additional content. You can add the location by browsing the Finder/Windows Explorer and selecting 
the correct folder. See the following example:

OFFICE STANDARDS (CONT’D)



FIGURE 2 
Setting up workgroup libraries location
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When these preferences are set correctly, resources are available in the Vectorworks Resource 
Manager and Resource Selector.

UNDERSTAND THE HIERARCHY OF RESOURCE FOLDERS

Using the recommended setup has many benefits, as it will make it easier when updating from 
version to version using the Migration Manager. Another benefit is that all your files will be in one 
location, simplifying the management and maintenance of them. When you want to update a file, 
you can quickly find it and move on to other tasks. Also, when organizing your resources in the 

“prescribed” way, all your resources will be available directly from the Vectorworks commands and 
tools, making any resources available instantly for any user connected to the server.

In Vectorworks, the workgroup folders will always get priority over the Vectorworks libraries.  
The priorities are set in the following order:

 ∙ Priority 1 = Workgroup and Project folders

 ∙ Priority 2 = User Data and Preferences folders

 ∙ Priority 3 = Vectorworks libraries

Vectorworks allows you to create multiple workgroup folders. The priority within the workgroup field 
is determined by a folder’s “stacking order.” You can move up or down the various paths to the top 
(in the #1 position) to prioritize the libraries you want to access first. An example of using multiple 
workgroup folders is when working “off-line” you may have a duplicate of your custom libraries 
available locally. This would be a preferred workflow when working remotely with no internet access. 

As described in this document, it is recommended to use the workgroup folder and locate your 
customized libraries on a shared server or on your local hard drive (for a sole practitioner).

OFFICE STANDARDS (CONT’D)
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FIGURE 3 
Resource Manager palette
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The Resource Manager is a palette in Vectorworks and can be accessed from the Menu bar by 
selecting the Window > Palettes > Resource Manager.

The palette is organized with a tool bar on top of the window, a file browser pane on the left, the 
resource viewer pane in the center, and the preview pane to the right. In Vectorworks 2018, you can 
choose a vertical or horizontal layout making it easier to dock your palette if you choose to do so.

For a detailed description of each button and function, click here. 

TOOL BAR:

The search box is very useful to quickly find resources. Since version 2017, and with improved 
search functions in version 2018, it is easier to find resources throughout all available libraries.

To refine your searches, use AND, OR, and NOT — these keywords are case sensitive. You can also 
place quotes around your search terms to search for exact phrases, and use asterisks to match  
one or more characters in a search term.

USING THE RESOURCE MANAGER

http://app-help.vectorworks.net/2018/9bblzxMhse4/eng/index.htm#t=VW2018_Guide%2FResourceManager%2FResource_Manager.htm%23XREF_12623_Resource_Manager&rhsearch=resources&rhsyns=%20


 9VECTORWORKS.NET

Sample search strings and their results are shown below:

FILE BROWSER PANE:

The file browser lets you navigate through the various resource library files available.

 ∙ Open Files displays all active and open files

 ∙ Favorites displays all files you added as a favorite

 ∙ Subscription Libraries displays all files available through 
your Vectorworks Service Select membership

 ∙ Vectorworks Libraries displays all files available by default when installing Vectorworks

 ∙ User Libraries displays all files in a user specific folder located on your local computer

 ∙ Workgroup Libraries displays all files that are typically located on a 
server where all users can access them simultaneously

ACCESSING RESOURCE LIBRARIES:

Toggle on/off the various resource libraries with the show/hide library icons in the tool bar. When  
a group is turned off, it will not display in the file browser pane.

You can also control the visibility of the Vectorworks libraries and subscription libraries by changing 
your Vectorworks preferences.

USING THE RESOURCE MANAGER (CONT’D)

SEARCH STRINGS  
(CASE SENSITIVE)

SEARCH RESULTS

“one two three”  
(with quotes)

This will match any resource that contains the word “one” immediately followed 
by the word “two” and then the word “three.”

One two three  
(without quotes)

These words will be joined with AND operators, which will match any resource 
that contains all three words — “one,” “two,” and “three” — in any field (name, 
tags, records, etc.) in any order.

“one two thr”*  
(with quotes)

This will match any resource that contains the word “one” immediately followed 
by the word “two” and immediately followed by any word that begins with “thr”.

one two thr* 
(without quotes)

This will match any resource that contains the words “one," "two," and any word 
that begins with "thr" in any order.

“one two thr*” This will match any resource that contains the word "one" immediately followed by 
the word "two" and then the word "thr*". The asterisk is not treated as a wildcard 
when enclosed with quotes.

“green table” AND  
“green chair”

This will match any resource that contains the word “green” immediately followed 
by the word “table,” and the word “green” immediately followed by the word 
“chair.”

window NOT  
Andersen

This will match any resource that contains the word “window” but does not 
contain the word “Andersen.”

http://vectorworks.net
http://vectorworks.net


FIGURE 4 
Vectorworks preferences

FIGURE 5 
Resource folders within a file
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Note: If you choose to disable the Vectorworks and subscription libraries in the 
preferences, these resources will be hidden from the Resource Manager and Resource 
Selector. By taking this action, you will be changing the Vectorworks behavior to look only 
at the user or workgroup folder when using various tools and the Resource Manager.

ORGANIZING YOUR RESOURCES:

Organizing your resources with the Resource Manager is easy as you can drag and drop the 
resources between files, or you can use the Import command from the context menu. Within a file 
you can further organize all the resources by folder (resource folder). You can select the New Folder 
button at the bottom left corner, and then select the resource folder. Each folder contains one type 
of resource, for example a line type folder can only contain line type resources.

USING THE RESOURCE MANAGER (CONT’D)



FIGURE 6 
Example of a workgroup folder structure located on a shared network
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CREATE A WORKGROUP FOLDER

A workgroup folder must contain the same sub-folder structure as the Vectorworks Libraries 
similar to FIGURE 6 below.

Once you have created the folder structure on your server, you must assign this workgroup folder in 
the Vectorworks Preferences (see FIGURE 2).

In the example shown in FIGURE 6, the selected path will be:

 ∙ Shared Folder > OFFICE STANDARDS > VW 2018

After you have updated your preferences settings, you will need to quit the Vectorworks application 
and re-open it so you can see the changes applied in the Resource Manager and Resource Selector.

 ∙ Open your Resource Manager and verify that your Workgroup Library is available 
in the file browser pane. If it is shown, this means the setup was successful.

Note that Defaults AND Object Styles Libraries need the prescribed 
folder structure as shown in FIGURE 6. These folders are needed to access 
the resources from the Resource Selector. Any files located at the first 
level of the folder will be visible from the Resource Manager only. 

CONFIGURING WORKGROUP FOLDERS

http://vectorworks.net
http://vectorworks.net
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HOW TO ACCESS DIFFERENT TYPES OF LIBRARIES

Out of the box, Vectorworks’ behavior will be to look at the Vectorworks Defaults and Object Styles 
Libraries. For example, when selecting a hatch fill, the Resource Selector will show only the 
hatches corresponding to the active files or the Vectorworks defaults. In FIGURE 7 you can see the 
Resource Selector will automatically show the corresponding resource in the Defaults libraries. 
This behavior will change if you have a workgroup folder assigned. In this case the Resource 
Selector will automatically look at the workgroup folder. See FIGURE 8.

CONFIGURING WORKGROUP FOLDERS (CONT’D)

FIGURE 7 
Resource Selector - defaults library
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Vectorworks Libraries - Default Title Block Border Styles

FIGURE 8 
Resource Selector - workgroup library
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Workgroup Libraries - Custom Title Block Border Styles

Note: The custom library 
file may have to be 
selected once within the 
Resource Selector after 
you set up your workgroup 
folder. Vectorworks will 
remember to look at the 
correct location after it 
has been selected. You can 
also “force” the selection 
of the custom library 
within the Resource 
Selector by filtering off 
the Vectorworks Libraries 
(show/hide library 
icons) in the Tool bar.
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Updating your resource libraries is easy using the new Resource Manager. For example, 
if you want to update a file contained in your libraries you can simply navigate to it 
from the Resource Manager and then right-click and select “Open.” Once open, you 
can fully edit the content and save the file. You can also drag and drop resources 
between files from the Resource Manager without opening or saving the files.

By locating these files on the server, no additional steps need to be taken. The updated content 
will be visible to all users after they refresh the libraries from the Resource Manager. 

HOW TO MANAGE RESOURCES

FIGURE 9 
Resource Manager refresh function

http://vectorworks.net
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CLOSING

In summary, managing custom libraries (or office standards) with the new Resource Manager is 
very efficient. There are a few preliminary steps that need to be taken if your firm has not adopted 
an office standard. 

1. Establish the common conventions for your modeling techniques and file setup.

2. Gather existing resources or create new resources.

3. Make these resources available to all staff to allow more 
time to be spent on the design of your projects.

With this document, you can download a sample custom library which can jump start the production 
of your own libraries. Remember that you can also use the Vectorworks default content as a 
starting point, adapting and modifying it to suit your needs.

The custom library includes the prescribed folder and sub-folder structure with a few sample files. 
Simply save this folder on your server, assign its path in the Workgroup Folder Setup dialog box (in 
the Vectorworks Preferences) and start building your own.

Download Sample Custom Library here.

FIGURE 10 
Example of the sample custom library 

Other Libraries

Default Content Libraries

PIO Style Libraries

http://download2cf.nemetschek.net/bim/OFFICE+STANDARDS.zip
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